
Chapter 10

Maxsurf Motions Guidelines

10.1 Assumptions

In addition to the basic assumptions discussed in class (and listed in reference 1) book,
the principle of superposition is used to compute the response of the vessel to irregular
waves. Simply, this means that the contributions to the motions of the individual regular
waves making up the irregular sea spectrum may be summed to obtain the total response
of the vessel to the irregular seas. Currently Maxsurf Motions is based upon linear theory,
therefore anything leading to nonlinear behavior (i.e. emergence or submergence of the
bow or stern, 3D flow e↵ects and flow interaction in a longitudinal direction along the hull
including dynamic lift at speed, etc.) will cause the results from Motions to be inaccurate.

10.2 Getting Started

Choose Open from the File menu and select a MaxSurf design file. The next step is to
Measure the Hull. Choose Analysis — Measure Hull from the menu. Default is 11
equally spaced sections. This is adequate for initial calculations, but more sections (15 - 30)
are needed for accurate predictions. If any surfaces of your MaxSurf file are trimmed, be
sure the Trim surfaces box is checked.

Be sure to check your Units and Frame of Reference under the Data menu.

By default, the sections are mapped with Lewis sections (number of mapped sections = 3).
The Lewis mappings are calculated from the section’s properties: draft, waterline beam and
cross-sectional area. This will not be accurate enough for sections that are very wide and/or
deep and have a low section area (or sections which have a skeg, rudder or keel). Motions will
automatically choose the best Lewis section that can be fitted to the section. It is normally
advisable to remove appendages from the design as this will result in better modeling of the
main hull. This will have little e↵ect on the heave and pitch motions. For more accurate
mapped sections, up to 15 terms may be used. This increase in mapping terms can lead to
conformal mapping sections that better match the actual hull sections. If an error message
appears reading “SI NLIN: Hydrostatic calculations failed.”, Motions was unable to form a
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mapped section - typically at an extremity. This can normally be solved by ensuring that
all sections can be formed, either by moving the perpendiculars slightly or by adjusting the
model surfaces in Maxsurf.

There are a number of other hull parameters that need to be set before Motions can run
its analysis. The items are found under the Analysis menu.

• Setting the Vessel Type (monohull in most cases)

• Setting the Mass Distrubution (Motions requires the pitch and roll inertias)

• Setting the Damping Factors (Additional damping may be added to the heave and pitch
response - the specified nondimensional damping is assumed to be evenly distributed
over the length of the vessel: typically leave this as zero; Roll total damping due to
viscous e↵ects must be added manually - typical values for most vessels are between
0.05 and 0.1: Lewis 1989 gives a value of 0.05 for typical ships without roll suppression
devices)

• Specify Remote Locations (Motions calculates the motions at the center of gravity and
any other specified potions on the hull away from the CG - Motions will calculate the
absolute and relative (to wave surface) vertical motions, velocity, and acceleration and
MSI at each location)

• Environmental Parameters (water density, deep water)

In the inputs window, the vessel speeds, headings and wave spectra must be entered.
Speeds must be less than Froude numbers of about 0.6. The wave spectrum type may be
selected from five standard spectra:

• ITTC (or 2 parameter Bretschnieder)

• 1 parameter Bretschneider

• JONSWAP

• DNV

• Pierson Moskowitz

For spectra requiring a wave period to be entered, the user may enter the model period (To),
the average period (Tave), or the zero-crossing period (Tz). The Pierson Moskowitz spectrum
is based on wind speed. If this spectrum is selected, the other spectral parameters will be
estimated from the wind speed entered.

If no speeds, headings and spectra are selected for testing it is not possible
for an analysis to be run.

Once you have specified the hull geometry, the hull mass distribution, the roll damping
and the environment conditions, you may proceed with the analysis.
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10.3 Analysis

There are various options to control the exact formulation and solution of the strip theory
problem. Under Analysis — Method...

10.3.1 Transom Terms

According to the underlying strip theory formulation, corrections should be applied to vessels
with transom sterns. These corrections have the e↵ect of increasing the heave and pitch
damping and thus reducing the maximum response of the vessel. The Motions manual
suggests that the inclusion of transom terms may over-predict the damping and it is suggested
that the results be compared for calculations with and without transom terms and the user
use their judgment as to which results are the most plausible.

10.3.2 Added Resistance

Four alternative methods are provided for the calculation of added resistance. The di↵erent
methods will give di↵erent results and again the user must use their judgement as to which
are the most likely. Salveson method may be applied to oblique waves. Other methods only
apply to head seas. For more information, refer to the Motions manual.

10.3.3 Wave Force

Two alternative method for calculating the wave excitation may be used.

• Head Seas approximation: speeds up the calculation to some degree. This method is
exact in head seas and can be applied with reasonable accuracy up to approximately
20� either side of head seas, i.e. 160� < µ < 200�.

• Arbitrary Wave Heading: this method does not make the head seas assumption, but
it is somewhat more computationally intensive.

10.4 Conformal Mappings

After the hull has been measured, the conformal mappings which are used to approximate the
vessel’s sections should be computed. Motions will first calculate regularly spaced sections
along the waterline of the vessel. To view the mapped sections (must be in Perspective View),
click on the Display — Visibility... and check the Mapped Sections toolbar button. Note
that, in general, due to the limitations of the conformal mapping technique, the mapped
sections will not be an exact match to the actual hull sections. However, these mapped
sections are only used to estimate the hydrodynamic properties of the hull and, in most
cases, these will be calculated with su�cient accuracy for the strip theory analysis. The
main limitations of conformal mapping are:

1. The mappings always cross the axes at 90�
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2. The sections are continuous (chines will be rounded o↵)

3. There are limitations in the range of section breadth to draft ratio and sectional area
coe�cients that can be accurately mapped.

Once you are satisfied with the mapped sections, you may proceed with calculating the
vessel’s response: select Solve Seakeeping Analysis from the Analysis menu.

10.5 Results

The results may be viewed graphically or in tabular format. To view the results table, select
Results from the Window menu. You may view di↵erent sets of results by selecting the
di↵erent tables (tabs) of the Results window.

• Summary Table results - this table diplays mo, RMS and significant amplitude of
the di↵erent motion, velocity and acceleration spectra of the vessel for the specified
conditions

• MSI - Motion Sickness Incidence

• CG RAOs - gives the computed vessel RAOs for the principle degrees of freedom at
the center of gravity. The phase lag of the motions is also given. The added resistance
coe�cient in regular waves is also provided

• CG Spectrum - gives the specified wave spectrum, in wave and encounter frequency
domains.

• Remote Location Spectrum - repeats the encountered wave spectrum and gives the
response spectra at the specified remote location. Absolute and relative vertical dis-
placement, velocity and acceleration spectra are calculated. The vessel is assumed to
be a rigid body and the e↵ects of heave, roll, and pitch are combined. The remote
location for which the spectra are displayed may be selected from the pull-down menu
in the Results window toolbar.

• Global Hydrodynamic coe�cients - these are the integrated coe�cients, cross-coupling
terms and excitation forces in the equations of motion of the vessel. These are the
total values for the complete vessel.

• Sectional Hydrodynamic Coe�cients - the added mass, damping, sti↵ness and wave
excitation for each of the sections of the hull at each of the frequencies of interest. The
section displayed and/or frequency shown can be selected from the pull-down menus
in the Results window toolbar.

10.5.1 Graphs

All the above datasheets, except for the integrated values, may be graphed and displayed in
the graph window:
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• MSI

• RAO

• CG Spectra

• Remote Spectra

• Global Hydrodynamics

• Section Hydrodyamics

The section data (Sectional Forces and Sectional Hydrodynamic Coe�cients) may be plotted
and displayed against frequency (for a single section) or against section position (for a single
frequency). To change the format, choose Section Data from the Display menu.

The Polar Window displays iso-response contours. The global vessel response to be
plotted is selected from the drop-down list in the toolbar. At least two di↵erent headings
(which are separated by less than 180�) must have been analyzed. Because the polar
plots require the speeds and headings to be ordered, these will be sorted at the start of the
analysis.

The spectrum plotted is selected from the Results toolbar. The concentric circles corre-
spond to the range of speeds covered and the radial arms the vessel headings: stern waves
(0 degrees) is at the top and bow waves (180 degrees) is at the bottom.

10.6 Animation

There are three options for the free surface: static (flat) and - once the analysis has been
performed - regular and irregular wavy surfaces may be used.

Roll decay simulation does not calculate a free surface, however when you select animate
from the Display menu, a simulation of a free roll decay test will be displayed. This simulates
the roll motion of a vessel heeled over to a specified initial roll angle and then released. The
initial heel angle is held for 5 seconds, then the vessel is released.

10.6.1 Roll Decay Simulation

• Make sure you have specified all Seakeeping input data correctly by working your way
down the analysis menu

• Solve Seakeeping Analysis from the Analysis menu

• Calculate the Wave Surface from the analysis menu

• Select Roll decay simulation in the dialog that appears

• Specify the initial heel angle

• Select Animate from the display menu (make sure you are in the Perspective View)

• Click OK

You can save the roll decay as a text file and import into Excel for further analysis of the
Roll decay simulation data.
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10.6.2 Regular Wave Surface

With this method selected, a single frequency and amplitude regular wave pattern is cal-
culated. The wave frequency is one of the discrete wave frequencies for which the motions
have been solved. The wave amplitude (half the wave height) may be either automatically
calculated (LOA/40 or limited by maximum wave slope for non-breaking waves: ⇣max = �/14
for short wave lengths) or may be specified by the user.

10.6.3 Irregular Wave Surface

This option allows an irregular wave pattern to be calculated based on the selected wave
spectrum. The irregular wave pattern is calculated by superimposing linear regular sin-wave
components. The number of wave components to be used can be changed by the user. The
wave components are chosen so that the wave energy in each frequency is the same - each
component is then given a random phase.

Once the wavy surface has been calculated, it may be displayed. A grid representing
the wavy surface may be turned on by selecting the Wave Surface option in the Display
— Visibility dialog. The wavy surface may also by displayed by turning on the rendering
(Display — Render).

After calculating the wave surface, Motions is able to animate the vessel for the specified
intial roll decay angle or in the selected wave pattern. Choose Display — Animate to start
the animation and use the Escape (Esc) key to terminate the animation. An output text
file contains the statistics and time series for the wave elevation and heave, roll and pitch
motions.

10.7 Saving the Motions Model

After loading the Maxsurf model and preparing and running the Motions analysis, the Mo-
tions specific model and input data can be saved into a separate .skd file. Choose “Save
Motions Data” from the file menu. This will save all input data was as well as all analysis
settings of the Motions model. To save the results, you can save each table separately, or
you can save all analysis results, including the Motions input data, in one file. To save all

analysis results choose: File — Save Motions Data As... and select “Motions analysis results
(*.skr)” as the file type. (Note: these files can be large.) To re-open the data at a later date,
first open the Maxsurf model, then choose the relevant “Motions analysis results (*.skr)” file
from the File — Open Motions Data dialog. Make sure you switch to the Motions analysis
results (*.skr) file format in the open dialog.

10.8 Reference

The information found in this handout is all from the Motions Manual.


